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Using Crystal Reports with Lucity 
Beginner Examples – 1  

The first of a seven-part series, this workbook is designed for new Crystal Reports® users.  You’ll learn 
how to make small modifications to an existing report under a new report name, and link your 
customized report into Lucity.   

The easiest thing to do using Crystal Reports is to modify existing reports.  Many times the existing 
reports offered within the modules are very close to what you had in mind.  There may simply be a 
missing field, a field that needs to be added or moved, an agency logo added, or simple formatting 
changes that would make the report just right.  The following information should help you make the 
reports your own. 

Note:  You must own a copy of the Crystal Reports software in order to modify existing 
reports or create new reports. 
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Lucity provides a Request Summary Report that looks like this: 

 

 

We would like to change the report to make it look like this: 

 

 

Finding the Report Location and Name 
 

1. Open the Lucity module where the Request Summary Report is located. 

o Select Work>>Request from the Lucity main menu. 

2. Open the Reports dialog.  Click the report icon  on the module toolbar. 

3. Locate the report to be modified and highlight it. 

o Summary of Requests 

4. You’ll see the Report File Path at the bottom of the dialog box.  This path tells you important 
information about the report. 

o The first part of the path tells you where the report file is located.  In our example 
below, the report is located at C:\Lucity76\Reports\Work\. 

 

Note: Lucity report files are stored in the shared files location designated during your initial 
installation.  This is typically on a file server, but could be on your local machine.  In the 
path shown below, C is a mapped drive.  This could also be a UNC path using the full server 
name.   
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o The report name appears after the last backslash.  As you can see below, this report is 
named ReqSum.rpt. 

 

In the report location the Reports Directory can be sorted by Name or Date Modified by clicking on the 
title in the upper bar. 

 

Renaming Reports 
If you modify a report and save it under the original name, the changes you made will be overridden 
the next time Lucity is upgraded.  Thus, reports that are modified need to be saved under a new name 
in order to be used.  Note: You must have adequate permissions to save the modified reports.  If you 
are not sure whether you have these permissions, check with your system administrator. 

 

1. You’ll want to make a copy of the report before you begin working on it.  You can do this by 
simply exporting the report from the Lucity module’s Report List to the Report Directory under 
a different name. 

 

 

 



Beginning Crystal 1  5   

2. It’s a good practice to establish a naming convention for your custom reports that makes them 
easy to distinguish from the Lucity standard report names.  For example, you might want to 
add a two or three letter abbreviation for your company or organization or perhaps your initials 
to the original report name as a prefix or suffix. 

o Some sample custom report names are LC_ReqSum.rpt or ReqSum_LC.rpt.   

o Adding the abbreviation to the end of the report name (before the .rpt extension) will 
allow the custom report to be sorted with the original. 

o Adding the abbreviation as a prefix will sort all of your custom reports together. 

3. Lucity reports store database connection information.  When the report is run in Lucity, the 
program replaces this connection information with connection strings specific to the 
customer’s database configuration during run-time.  When you export a report, the database 
connection information used at run-time is saved.  This is the preferred method for handling 
Lucity reports and will ensure that the report stays pointed to the correct data set so that the 
report can be run out in Crystal. 

Exporting a Report 
As we mentioned above, the preferred way of handling Lucity reports is to export them.  This allows 
you to rename the report and make modifications as well as maintain your database connection 
information.  Follow the steps below to export a report: 

1. Within the Reports dialog click All Records. 

2. Highlight the report you’d like to copy and select Export Report. (Wait) 
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3. An Export dialog will appear.   

o Select “Crystal Reports” from the Format drop down box. 

o Then, select “Disk file” in the Destination drop down box and click OK. 

 

 

4. The following dialog will appear: 

  

 

 

5. Find the location where the report is to be stored.  It is recommended that you use the default 
report location discussed in the previous pages. 

6. Type in a new File Name (LC_ReqSum.rpt. 

7. Click Save. 
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8. At this point the report needs to run, so if the subtitle query shows up, just click OK. 

Note: If the Export takes more than a few seconds then cancel and change the Report filter 
to “This Record Only”.  This may be necessary for complex reports, especially ones with 
subreports.  Then Export (follow above steps 2 – 8).   

 

 

9. Close the Report dialog. 

10. Minimize the Lucity module. 

11. In the Reports Directory, open the new report that was just exported. 

o On the report title either Right click and select Open or double click.  

12. From the menu bar at the top of the screen, select File. 

13. Uncheck the Save Data with Report option.   

14. Click Save. 

15. If the report is Exported with This Record Only then the Select Expert needs to be opened and 
the ID selection formula deleted. 

o Click Select Expert . 

o Click Show Formula>>>. 
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o Click and drag over the formula. 

o Press Delete key to remove. 

o Click OK. 

o Click Save. 

o You are now ready to begin making modifications to the report. 

Note:  Reports with “secure” fields may show as “Hidden” but this is temporary and can be 
changed when refreshing the report and choosing the “Prompt for new parameter values”.  
If date fields were required to run the report these too would be temporarily placed in the 
report until the report is refreshed and new parameters are given. 

Options 
Whether a report is modified or created new, it is helpful for certain report options to be set before 
working on the report.  Within the Crystal Reports Options and Report Options there are a number of 
settings that can be preset for generalizations.  These can be changed for individual reports or 
individual fields within a report. 

1. To view the “Options” section, we will look at the previously exported report, LC_ReqSum.rpt. 

o In the Menu Bar click File >> Options 

2. The following screen captures show you what options can be changed behind the scenes. These 
options will be reflected in all of the reports created. 
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For each field type there are format options specific to that type. 

String 

 

Number 
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Currency 

 

Date 
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Time 

 

Boolean 
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Each Field or Object type opens the Font options. 
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Report Options 
Report Options are specific to an individual report.   

o In the Menu Bar click File >> Report Options. 

These Report Options are also available within Subreports (discussed later). 
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Document Properties 
Another useful Crystal option is Document Properties.  This information could help in report 
documentation.  Some of the fields are available to be used in the report.  They are found in the 
Special Fields section listed in Field Explorer (Discussed later).   

o In the Menu Bar click File >> Summary Info… 

 

 

 

 

Notes:___________________________________________________________________________________
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Report Sections 
Every report has a minimum of five sections.  These sections show on the left side of the report.   

 

 

To conserve space this section can be reduced in size by right clicking in the section and selecting Show 
Short Section Names. 
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Modifying a Report 
Beneath the toolbars the open report will have a tab with the report name.  Beneath this, the exported 
report already has two tabs available, Design and Preview.  If the report is opened from the report 
folder then the Design tab will be present but the Preview will only show after the report is run. 

 

 

The Design page is where most of the report modifications will take place but can be done in Preview. 

Note: The undo and redo buttons are very helpful when revising reports.   
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Saving and Viewing your Report 

o Save any changes by clicking on Save .  It is a good idea to Save while you are working and 
not just when you are finished with the report. (You never know when you will encounter one 
of those mysterious error statements that shuts you down, forcing you to lose all of your work). 

o To preview the report, click Print Preview . 

o To refresh the report, click Refresh . 

o To limit the number of records previewed: 

 In the Menu Bar click View. 

 Select Preview Sample… 

 Select First and type in the number of records you would like the report to run with.  
This is particularly helpful when you have large numbers of records to deal with. 

 

 

Note: If you are looking for a specific record in Preview mode, you can use the Find Tool 

button  and enter the data you wish to find. 

Field Types 
Field types include Text Objects, Database Fields, Formula Fields, Field Titles, Parameter Fields, 
Running Total Fields, Group Name Fields and Special Fields. 

When the cursor is placed over the field boxes, field type information appears if Tooltips is turned on.   

o If you place the cursor over the Request # box, Text Object appears.  This means that Request 
# is a group of characters that can be modified.  This is a column header that was manually 
typed in.  

o If the cursor is placed over RQ_Number, it shows the table (WKREQ), field name (RQ_NUMBER) 
and data type (string).  Depending on the age of the report the default field caption may also 
show.  This Database Field is bringing in data from a table.  In Field Explorer (discussed later) 
the previous tooltip information may show as well as the size of the string mask for the field. 
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Changing Text in Text Objects 
In the example report, LC_ReqSum.rpt we will change the text object field “Request #” to “Request 
Number”. 

To change the text within a Text Object: 

1. Double click on the box with Request #. 

2. Click and drag over the portion you want to change (#).   

3. Type the new text (Number) and click out of the box.  

        change to      

 

Field Sizing 
Sometimes it is necessary to resize or delete existing fields to accommodate additional text or make 
room for a new field. 

Resize a Text Box: 

1. Click on the text object (Problem) which will highlight the borders of the box. 

2. This will activate the the sizing handles, the small dark dots on each side of the box. 

 

3. Place the cursor over the right border’s mark which will turn the curser into a two 
sided arrow.  Click and drag the box to the left to reduce the empty space.  

       

Resize a Field: 

1. Click on the field (RQ_PROB_TY). 

2. Click on the right sizing handle and drag to the left (to about 7.5” in the top ruler). 

Deleting a Field 

Delete a Field: 

1. Click on the field (RQ_PRTY_TY) to highlight it. 

2. Press the Delete key  

   OR 

  Right click in the field and select Delete 

Field Movement 
1. The Simplest form of moving fields is by clicking on the field and dragging it to the new 

location. 

o Click on the Priority text object (resize to reduce the empty space). 

o Drag to the right until the left edge is aligned with the 5” mark. 
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2. Multiple fields can be moved by holding the shift key down while clicking on the fields.  This 
will highlight the fields which can then be moved or sized or formatted all at the same time. 

The click and drag feature, as well as the adjustment of the box size, are done to the 
highlighted box with the four dark marks on the edges (anchor box). Multiple fields may be 
copied or cut as a unit as well.   

 

3. Multiple aligned fields can be moved as a unit by “attaching” Guidelines to the fields.  This can 
be done both horizontally and vertically using the rulers at the top and left side of the report 
(if this option is turned on). 

o In the top ruler, click near the 6” mark and hold, moving slightly if necessary, until the 
dotted line meets the left side of the Problem text box. Release 

o The left side of the text box will appear red and there is a pointed box in the ruler 
section.  

o The left edge of the RQ_PROB_TY field will likely be red as well but if not, click on the 
field and drag to attach the left side to the guideline. 

 

o To move the fields attached to the guideline, click on the ruler marker and drag it to 
the new location. (about 6 5/8”)  This will move any fields attached to the guideline. 

Note:  Caution should be used with guidelines if there are a number of fields in the 
report.  You may attach fields you had no intention of moving.  This is a problem that 
can affect Lucity Detail reports. 

o To remove a marker, click on it and drag it up and away from the ruler.  Then, release 
your mouse.   

o All markers can be removed with a right click in the ruler or body of the report and 
then selecting either Remove All Vertical Guidelines and/or Remove All Horizontal 
Guidelines. 
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Add a Text Object 
Make sure there is room to add the text object.   

In the example we will create space between the Status Date and Priority: 

o Reduce the size of the Status text object to close up the empty space. 

o Reduce the RQ_STAT_TY field (right edge to 3 1/4”).   

o Move the Status Date text object and @StatDate field to the left (right edge 4 1/8”).   

This has opened up space to add a new text object. 

To add a new text box: 

1. Click (release – don’t drag) on Insert Text Object .  The cursor turns into a plus sign. 

2. Click on the location where the box is to be inserted.  Just to the right of the Status 
Date text object. 

3. Type in the desired text (Follow-Up).   

4. Click out of the box when you are finished.   

5. Resize to close up the empty space.  In the example it is overlapping the Priority text 
object.  It doesn’t hurt anything but may hinder your design efforts later. 

 

Adding Fields 
To add a field, you may need to make room by moving or removing existing fields.  

1. In our example, we’ll change the “Priority” column to “Category”. 

o First, you’ll edit the Priority column header to read Category. 

o The RQ_PRTY_TY field has already been deleted. 

o Now, you’ll add the new “Category” field (as shown below). 

 

2. You’ll need to find out the name of the “Category” text field. 

o Go back to the Requests module and locate the field that is to be shown in the report.   

o With your cursor in the field, press Ctrl and then right click.   

o Select Field Definition. Some fields, including the Code field, have an additional 
option, Field Properties.  This option offers additional information such as the filed 
Mask and editing options. 

o In the example, you can see that the table name is WKREQ and the “Category” field 
name is RQ_CAT_TY.  
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Note:  

Sometimes fields that have a code box and a text box will only show the field definition of 
the code portion. The only difference with the text portion is that the field name would end 
in TY rather than CD. 

Sometimes if the box is pulling information from a different module, the field definition will 
not show up or the given field name may not be accurate.  It may be a connecting field to 
pull the correct data from another table. 

 

3. Return to the report.  Then, complete the following steps to add the new field. 

o Open Field Explorer.   (Also under “View” in the top menu bar) this may already be 
open on the right of the report. 

o Open Database Fields (click on the + sign).   
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o Open the WKREQ table (click on the + sign).   

 

 

o Click and drag the RQ_CAT_TY field and place it in the Detail section under the 
Category column heading. 

                   

When a field is used in the report, a check shows up next to it in the Field Explorer. 

                   

 

In the example we will now add the X and Y Coordinate fields: 

1. Change the Address text object to X Coord. 

2.  Reduce the box width to close up the space.   

3. Add another text object called Y Coord to the right of the X Coord.   

4. Right align both the X and Y Coord text objects.   

5. Delete the @Location field.   

6. Add the appropriate fields below the X and Y column headers. 
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Special  Fields 
There are a number of “Special Fields” that Crystal Reports provides.  In Field Explorer expand Special 
Fields. 

  

 

The report is currently using Page Number, Print Date and Print Time.  If the Summary Info… had 
been filled out for the report then several of these fields would have been available to bring into the 
report (File Author, Report Comments and Report Title). 

The File Path and Name could be a helpful field to place in the Report Footer.  This would tell you 
exactly where the report is located and the exact report name (LC_ReqSum.rpt). 
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Copying Fields  
A field that is used in a report can be copied and used elsewhere in the report. There are various 
methods for doing this. 

o Click on the field(s) and:  

 Right click Copy and then right click Paste to the new location. 

 Or - Ctrl C to copy then Ctrl V to paste in the new location. 

 Or – for a single field - hold Ctrl, click and drag to new location and release.  

Formatting Fields 

General Formatting 
If you want a field to stand out, there are various tools you can use.  You can change the lettering size, 
font, or color of the text as well as change it to boldface, italics, or underline.  The options are 
located in the Formatting Toolbar (pictured below).   

 

Formatting can also be accessed by right clicking on the field and selecting Format Field… 

Click on the box containing the text you wish to change.  Then, select the options to be used. 

If partial text is to be changed, double click on the box and then click and drag over the part that is to 
be changed. 

In the example report change the column header text objects to be Bold.   

1. Hold the shift key down and click on all boxes that need changing. 

2. Click on the B (for bold) in the toolbar.  

3. Resize any boxes to accommodate the bold text. 

Preview the report. 

 

 

The X and Y coordinates are showing with two digits to the right of the decimal and the actual values in 
the record require 8 digits. 

  

Number Formatting 
Number fields may require formatting for many reasons such as decimals, rounding, negatives, field 
size where the value is showing ##### or the numbers are cut off.  The field size can either be 
increased, or the field can be reformatted to remove the decimals.   

To change the format of the RQ_X_COORD field: 

1. Right click on the field and select Format Field…. 
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2. Click on Customize…   
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3. Click on the down arrow next to “Decimals:” and select the correct option for the number of 
digits. 

4. Repeat for “Rounding”. 

  

5. Select OK to close the Custom Style dialog. 

6. Select OK to close the Format Editor dialog. 

      In the preview tab the X Coordinate value is now showing: 

     

7. Increase the field size with the sizing handles on the field. 

  

Another issue that sometimes occurs is the clipping of numbers.  This is where you see 
incomplete numbers instead of the ###.##.  This is not recommended.  This option is located 
in the Custom Style dialog box.   

  

Make sure the “Allow Field Clipping” box is not checked.   
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Copying Formatting  

The Y Coordinate will need similar formatting.  The Format Painter can be used to copy the X 
Coordinate formatting onto the Y Coordinate field as follows: 

1. Click on the RQ_X_COORD field. 

2. Select the Format Painter in the Standard Toolbar  . 

3. Click on the RQ_Y_COORD field.   

4. Increase the field size to accommodate the additional digits. 

    

 

Note: Many cost fields within Work reports are fields that will be “Hidden” if the person 
running the report does not have the proper security.  The way this is achieved turns the 
number field into a “Text” type field thus normal “number” formatting does not work on 
these fields. 

 

Alignment of Fields 
1. Shift click on all fields to be aligned. 

2. Right click on the field you want to size and align with, the darker markers will show up on the 
field you select. 

3. To size, click Size > Same Height. 

4. To align, repeat steps 2 and 3, clicking Align > Tops (or Bottoms, see what looks better). 

5. Do this for both the Column Headers and fields in the Detail section. 

Note: If a section has only a single line of fields, then all fields can be selected by right 
clicking in the left margin of the section and selecting “Select All Section Objects”.  This 
option wasn’t available in our example due to the line in the Detail section. 

 

Using Formulas 
Crystal provides a way to create formulas that can be used in record selection, conditional formatting, 
conditional suppression and calculations to name a few. 

Date and Time Fields 
In Lucity the date and time fields are a DateTime type field.  If the Date field is brought in directly 
with the Options (File > Options > Fields > Date and Time… > Date and Time) set as System Default 
Short Format, the date field when brought directly into the report will look like this: 

   

The time portion is not a good value.  

In the same way the Time field will look like this: 

   

The date portion is not a good value. 
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In the Options Field Formatting the Date and Time type field could be set up to always show a date 
(without time) but then the time field would also show as a date. 

The proper way to handle the DateTime fields is with a formula.  The formula will take out the 
required portion of the field. 

Note:  Formula fields begin with the @ symbol like the Status Date .   

Date Fields 

 In our example, we will add the Follow-Up Date. 

1. Within Field Explorer, right click on Formula Fields.  

2. Select New.   

3. Type in the name.  For our example, we’ve entered “FollowUpDt”.   

 

4. OK 

This will open the Formula workshop. 

 

It would be helpful to have the Hide/Show workshop tree highlighted  as well as the Field 

Tree, Function Tree and Operator Tree . 

5. Expand the Function Tree, Click the plus sign (+) in front of Functions. 

6. Expand Date and Time. 

7. Expand Date. 

8. Double click the Date(dateTime) option. 
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9. The following formula will show up in the lower box: 

Date() 

10. In the Field Tree expand the ODBC database.  In this case it is Work. 

11. Expand the WKREQ table. 

12. Make sure the cursor is flashing between the date parenthesis in the formula box then 
in the Field Tree double click RQ_FLLW_DT. 

13. The final formula will look like this: 

 

14. Click Save and close. 

       The new formula will now show under the Formula Fields in Field Explorer.   

   

15. Drag the new formula field into the Detail section, under the Follow-Up column 
header. 

  

Time Fields 

 A Time field which is also a DateTime type of field should also be set up in a formula.  It would 
 be created like the date formula except in the Formula Workshop in the Functions Tree the 
 Time option would be used to create the formula. 
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Note: Once the date has been pulled from the DateTime field in the Date formula it will 
follow the formatting in Options for Date.  In a like way the Time formula will now format 
as a Time field.  This can be changed in a general way out in Options or specificly with the 
right click Format Field… option. 

 

Documentation Comments 
Comments can be made within the Formula Workshop to help with documentation. The comments can 
be in a separate formula documenting all of the changes for the report or they can be specific 
comments to a formula.  Each line of a comment must be preceded by two forward slashes //.  This 
will change the font color (default green can be changed in File > Options > Formula Editor). 

A general comment will be added to the example. 

1. Right click on Formula Fields and select New. 

2. Type in “Comment”. 

3. In the lower section, type //.   

4. Next, type whatever clues you need to remember what was done.  We’ll type: 

 “Removed Priority and Address.  Added Follow-Up date, Category, and X & Y coordinates.” 

5. Select Save and Close. 

6. Drag the Comment formula to whichever section you will see it, like the Page Header. This will 
not show up in the Preview mode of the report but it is there for you to reference in the 
future. 

 

Note: Formulas created in the Formula Workshop can be typed in without using any of the 
“Tools”.  The Tool Fields, Functions and Operators may also be dragged in as opposed to 
double clicking. 
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Inserting Lines and Boxes 

Lines 
When reports have a great deal of information, it is often helpful to use lines to break up the data.  
This makes it easier to read.   

1. Click on Insert Line .  This turns the cursor into a pencil.   

2. Place the pencil point wherever you would like to insert the line in the report.  Then, drag the 
line across the screen until you have reached the desired length. 

3. The line characteristics can be modified by right clicking on the line and selecting Format Line.  
Several line samples appear below 

  

4. If any of the fields are able to grow, then in the Format Line dialog (right click on the line) 
select “Move to Bottom of Section when Printing”. 

  

 

This usually solves any growing issues, but sometimes the line should be given its own section instead. 
A new section can be added by right clicking in the left margin next to the section and selecting Insert 
Section Below.  These options can also be selected by typing the underlined letter. 

 

the “I” is underlined.  

All Crystal sections allow multiples.  They will show with a letter behind the section designation.  
 Example: Details a, Details b, Report Footer a, Report Footer b… 
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Boxes 

Another option is enclosing data in a box.  In the example we will place a box around the Total 
Requests text object and field (#TotReq) . 

1. Click on Insert Box .  This turns the cursor into a pencil. 

2. Place the pencil point wherever one corner of the box should be (top left of Total Requests 
box) and then drag diagonally to the other corner (bottom right of #TotReq box) and click.   

3. Right click on the box line and select Format Box…  

4. Select Fill:>>Color:  

5. Use the drop down arrow to select Yellow. 

6. Click OK 
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“Growing” Fields 
Sometimes, the data in a field is cut off and there is no more horizontal room to increase the field size.  
In this case, it is helpful to allow the information to be shown in multiple lines.  This can be done with 
the “Can Grow” option. 

To add or delete the “Can Grow” option, complete the following: 

1. In the example right click on the field (RQ_CAT_TY). 

2. Select Format Field. 

3. On the Common tab, check the Can Grow box. 
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Report Manipulation 
Lucity typically provides a Summary report and a Detail report for each module.  The Summary report 
is great for a quick overview of many records.  The Detail report usually shows all of the fields within a 
module.  It is much easier to delete fields and sections and move things around than it is to add 
information.  We’ll go over the steps to manipulate a report below: 

 

1. Copy the ReqDetail.rpt report.  This copy is just to “play” with so does not need to be 
exported or saved. (Copy and Paste) 

2. Open ReqDetail – Copy.rpt. 

3. Removing Sections: 

o Most Sections can be removed by right clicking to the left of the report and selecting 
Delete Section. 

 Right click on the left margin of the Detail g section and select Delete Section.  
The g section is removed and the Details sections will now rearrange their 
lettering.  The old h section is now g. 

o Some Sections cannot be removed but the information within them can be deleted. 

 Right click in the left margin of the Page Header section and choose Select All 
Section Objects.   

 Then press delete.   

o Another option is to suppress a section.   

 Right click in the left margin of the Detail c section and choose Suppress (No Drill-
Down). 

4. Moving fields around within a report can be challenging.  In this example, Detail a section, we 
will move Home Phone and Work Phone up to just below Phone Number.  

o To make room for these fields, place the cursor to the left of the report on the right 
edge of the ruler strip where the field is to be inserted. You’ll see a single line with 
double arrows.   

o Click, hold, and slightly wiggle, pulling to the right as you release to create a section 
break.   

o Click and drag the section break line to make room for the new fields. 

o Hold the Shift key and click Home Phone, RQ_HM_PHN, Work Phone  and 
RQ_WK_PHN to highlight the fields to be moved. 

o Click and drag the fields beneath Phone Number.   

o Right click in the Details section next to Phone Number and select Merge Section 
Below. 

Note: The Merge function may have caused the check next to Do Not Disclose to 
“disappear”.  Right click on the check box and select Move >> To Back. 

 

5. Report sections can be switched by clicking and dragging to the new location.  

o Click and drag section Dk to beneath Da.  This is now the new Db section. 

6. The report page orientation is another way to add room or shrink a report.  Landscape mode is 
always helpful if you need to add a couple of fields or see all of the text on one line.  This 
option is found in File > Page Setup. . . > Orientation. 
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Removing Parameters 
Parameters are special fields that query the user for information to be used in the report before the 
report will run.  Common parameters used in Lucity reports include subtitles and date queries.  These 
can be removed by clicking on the Parameter field and selecting Delete.   

The report no longer uses the parameter field, but the parameter exists in Field Explorer.  Unused 
parameter fields have been an issue in some of the Web reports.  To permanently remove the 
parameter field you must right click on the specific parameter field in Field Explorer and select Delete 
or click the field and press the Delete key.  Parameter fields are recognizable by the “?” at the 
beginning of the field: 

 

Inserting an Agency Logo 
You may want to have your agency logo appear on your customized reports.  This helps identify the 
report as one of your own.  To insert an agency logo, complete the following steps: 

1. You may need to make space in the report for your logo. 

o Right click somewhere to the left of the report in the Page Header section and select 
Insert Section Below.   

o In the new PHb section left margin, click and hold, the cursor should turn into a hand.  

o  Drag up into the PHa section and release.  The two sections have switched places. 

o Place the cursor over the line between sections PHa and PHb (it should turn into 
double horizontal lines with an arrow pointing up and one pointing down).   

o Click and drag down to increase the PHa section size so that it can accommodate the 
logo.   

2. To insert a logo into the Page Header a section, perform one of the following steps: 

o Click on Insert and select picture. 

 OR  

o Click on the Insert Picture icon .   

3. Then browse out to the location of your logo file and double click to add it to the report.  File 
format should be bitmap, TIFF, JPEG or PNG. 

4. You can resize the logo by clicking and dragging the corners and edges.  You can change the 
placement of the logo by clicking and dragging the entire picture. 

5. Resize sections as necessary. 

6. Finally, right click in the Page Header a section and select Merge Section Below.  You now 
have one Page Header section. 
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Adding a Report to the Module 
To use any new or revised reports within Lucity, you’ll need to add them to the module where you wish 
to view them.  The reports need to stay within the “family” for which they were created.  For 
example, you may not run a Work report in Sewer modules. 

1. Open the desired module.  (ex. Requests) 

2. Click on Reports  . 

3. Select Add.   

4. Click on the box with three dots  next to Report File Path.   

5. Find the report directory with the new report and double click on the report (LC_ReqSum.rpt).   

6. Enter the report name and give it a description.   

  

7. Select Save.  This report is now available to be used within the module.  

Accessing Reports in Lucity 
Within a module you may use any of the reports available in the reports dialog box.  Frequently used 
reports can be added to the Quick Reports option (drop down arrow next to the Report icon). This can 
be set up in the Reports dialog. 

Right click on the Report Title and select the type of Quick Report you would like saved.  This setting is 
on a User Login basis.  This allows various users to set up their own Quick Reports in whichever manner 
they’d like to see them. 

 

 

The report will be displayed with the hand  icon before the report name.   
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Another means to access a frequently used report is to simply add a number in front of the name to 
bump it to the top of the list. 

 

 

 

Datasource 
If standard reports are copied and pasted instead of exported and then run or verified in the Crystal 
software, the original Lucity connection information is maintained, but the connection information 
specific to the customer’s database won’t be available.  Thus, the report will be unable to find the 
proper database tables.  You should receive a warning message similar to the following – Select No: 

 

 

 

If you receive the warning message displayed above, you have the following options: 

o Delete this copied report and export the report from the Lucity module.  This process was 
explained previously. 

o You can manually point each table in the report to the correct datasource. 

o You can Batch Verify – only available with the Development version of Crystal XI. (Not 
discussed) 

The above options will repoint the connection strings.  This will allow you to run the report in Crystal 
Reports, which is the quickest way to test the report modifications.   
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Set Datasource Location 
Below, we’ve described the steps needed to set the Datasource Location for reports with database 
connectivity errors.  Remember, you’ll need to complete these steps if you’ve performed a “Save As” 
or copied and pasted a report and received a warning message informing you that certain database 
tables could not be found. 

 

1. Within the open report, click on Database in the toolbar at the top of the screen. 

2. Click on Set Datasource Location.  The following dialog will appear: 

 

 

3. In the bottom window, open the Create New Connection folder 

4. Open ODBC.  You’ll see the dialog displayed on the following page: 
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4. In the ODBC dialog, click on the correct Datasource name and then click Finish. 

o For example, here we’ve selected GBAWork001. 

 

 

 

 

Notes:___________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________ 
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5. You’ll return to the Set Datasource Location dialog.  Now, open Tables in the bottom window.   
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6. Next you’ll have to click on each table in the top window (Current Data Source) and find its 
match in the bottom window (Replace With).  Click on the matching table name and then press 
Update. 

o As you can see in the example below, we’ve selected the WKREQ table in both 
windows. 

 

7. After updating each table listed in the top window, click Close.   

o Make sure to perform these steps with the Subreport tables as well!!  

o If the matching table names don’t appear in the bottom window, open the Synonyms 
or Views tables and look for them there. 
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8. If a field type has changed or been removed from the table since the report was last updated  
then there will be an issue with Field Mapping and you will see something similar to this: 

 

 

o Sometimes unchecking the “Match type” checkbox will show the field to Map To but 
sometimes it doesn’t. 

o In Lucity 7.5 Work module > Tracking grid, the Tracked Item and Description fields 
were changed from a Text type field to a Memo type field.   There was no option to 
match the Unmapped Fields to so selecting OK allowed the rest of the mapping to 
complete.  When going into the Tracking subreport, these fields had been removed. 

 

 

 

o These fields needed to be manually brought back into the report with the new field 
types.  The fields have the same name; they are just a different type of field that 
allows more data.  
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Converting Desktop Reports to use in the Web 
Custom Reports that have been created for the desktop version of Lucity will NOT work in the Web 
application as is. To convert a report from a standard Lucity report to a Web report, complete the 
following steps:  

1. Open the report in Crystal Reports.  

2. Go to Database>>Set Datasource Location.  

o SQL Server Clients select OLE DB (ADO)>>Make New Connection. 

o Oracle Clients select Oracle Server. 
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3. If you are using SQL Server you will then be prompted to select a provider. Use the Microsoft 
OLE DB Provider for SQL Server as shown below.  

 

4. Next, enter the Connection information.  

o For SQL Server, include the SQL Server Name, User ID, Password, and Database. 
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o For Oracle, include the Service, User ID, and Password. 

 

5. Once you create a connection you will need to individually (manually) map every table from 
the report one at a time.  Don’t forget the tables in the Subreports! 

Note: Reports must be posted to the web server in the \Reports directory in order to be 
available online. There you will see sub-directories such as  \Equip\ or \Work\. Reports 
should be placed in the appropriate sub-directories. 

 

 

 

 


